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G L O S S A R Y

Glossary

angular dimension
A dimension that measures the sweep angle of an arc, the angle between an origin
and a line, the angle between two lines, or the angle among three key points.

annotation
Text, graphics, or symbols that give you more information about a drawing.

(A) Leader line

(B) Break line

(C) Terminator

(D) Annotation

associative
A condition in which an element is related to another element.

attribute
A user-defined property or parameter assigned to an element, object, or document.
A parameter refers to variables in a symbol document that drive dimensional
values. You can display attributes with the Attribute Viewer.

background sheet
A component of a drawing sheet. The background sheet is used for graphics that
you want to display on more than one drawing, such as a border, title block, logo,
or raster background picture (watermark). A background sheet can be displayed
and printed along with any working sheet it is attached to.
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balloon
A type of annotation that consists of a closed shape that contains text. A balloon
defines individual parts in assemblies and  field notes on drawings.

diameter dimension
A dimension that measures the diameter of a circle or arc.

dimension
A control that assigns and maintains a dimensional value to an individual element
or establishes a dimensional relationship among multiple elements. A label with
text, lines, and arrows graphically represents a dimension.

dimensional value
The text that indicates the value of a dimensional measurement, such as distance,
length, or angle.

document data
Annotations, such as dimensions, text boxes, callouts, balloons, and centerlines,
that are used to describe design data.

driven dimension
A dimension with a value that depends on the value of other dimensions or
elements.

driving dimension
A dimension with a value that controls the size, orientation, or location of an
element.

element
A simple, selectable unit in a drawing. You can select geometric elements,
dimensions, annotations, objects placed in the drawing through OLE, and so forth.
The type of element that can be selected is determined by command context.

embed
A method for inserting information from a source document into the active
document. Once embedded, the information becomes part of the active document;
if changes are made to the source document, the updates are not reflected in the
active document.

end point
The end of an element.
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fill
A pattern or solid color placed inside a closed boundary.

free space
An area that is not on or inside an element or object on a drawing sheet.

FreeForm
A drawing tool that allows you to use the mouse to sketch curves. As you press and
hold the mouse button and drag the pointer across the drawing sheet, a rough
sketch of your design appears. When you release the mouse button, the software
turns your sketch into smooth curves.

FreeSketch
A drawing tool that allows you to use the mouse to sketch lines, arcs, circles, and
rectangles. As you press and hold the mouse button and drag the pointer across the
drawing sheet, a rough sketch of your design appears. When you release the mouse
button, the software recognizes the shapes in your sketch and turns them into a
precise drawing.

from point
The starting point for an action. For example, when you rotate elements, the from
point determines where you want the rotation to begin.

handle
Solid or hollow squares that are displayed at significant positions on a geometric
element when you select the element. You can manipulate an element with a
handle.

help lines
The dashed coordinate axes displayed by PinPoint. The help lines extend from the
target point to the current pointer location. They are dynamically updated as you
move the cursor. You can turn the help line display on or off.

horizontal relationship
A relationship that specifies that the end points of a line, or two key points, are
level with each other along the x axis.

hyperlink
Colored and underlined text or a graphic that you click to go to a file, a location in a
file, an HTML page on the World Wide Web, or an HTML page on an intranet.
Hyperlinks can also go to Gopher, telnet, newsgroup, and FTP sites.
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intent zone
A quadrant divided into four pie-shaped wedges that determines the behavior of an
element’s relationship to either a circle or arc. Intent zones allow you to specify
where you want to draw an element in relation to an arc or circle. For example, as
you draw an arc, you can change the arc’s direction by moving the cursor to a
different position within the intent zone. You can define the size of the intent zone
by specifying the number of pixels in it.

isometric drawing
A drawing represented as the object or element is actually projected on a plane of
projection: a 3D drawing represented in 2D.

key point
A recognizable point on an element. Key points include vertices, mid points, center
points, and so forth.

layer
A logical grouping of elements or objects on a drawing sheet. You can have several
layers in a drawing sheet.

linear dimension
A dimension that measures the linear distance between two or more elements, the
length of a line, or the arc length of an arc.

link
The connection between an inserted image or object, known as the source
document, and the active document. Changes made in the source document are
reflected in the active document when the active document is updated.

locate zone
A circular area at the center of the crosshair cursor or at the end of the arrow
cursor. The locate zone specifies how close the cursor must be to an element you
want to recognize or select. You can define the size of the locate zone with the
SmartSketch command on the Tools menu.
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lock
A relationship that makes the position of an element or key point, or the value of a
driving dimension, stationary.

macro
A sequence of actions or commands that can be named and stored. When you run
the macro, the software performs the actions or runs the commands. You can
create the macros in Visual Basic or other OLE-aware programming applications.
Some of the OLE-aware programming applications are VBA (inside of Excel),
Visual C++ Delphi, Visual Basic, and so forth.

 modification
The act of changing the size, position, or orientation of an element by modifying the
element or its handles.

object
1. Information that can be linked or embedded into an OLE-compliant product.

2. A group of elements that represent a real-world object. An object can also be
made up of a single element.

OLE
The way Microsoft uses the Common Object Modeler (COM).  It is a mechanism
to make data work independently.

parallel relationship
A relationship that specifies that the orientation of one line is identical to that of
another line.

parameter
An attribute assigned to an element or object, usually a numerical value
representing a dimension. A parameter is a mechanism to change a property. A
parameter refers to variables in a symbol document that drive dimensional values.
Parameters appear as bold characters in the Attribute Viewer.

parametric symbol
A symbol that contains geometry constrained together using relationships, with
driving dimensions that are defined as adjustable parameters.
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perpendicular relationship
A relationship that specifies that the orientation of a line or end point of an arc is at
a right angle to the orientation of another line, arc, circle, or curve.

PickQuick
An automatic software tool that allows you to select an element when several
elements overlap. When you place the pointer over a set of overlapping elements,
three small circles appear at the bottom right of the cursor. When you click, a small
toolbar with the number of selectable elements appears. You can move the pointer
over the numbers; and, when the element that you want highlights, you can click on
the corresponding number to select it.

PinPoint
A tool that allows you to place, move, and modify elements with precision, relative
to a reference point.

pointer
The screen device that you use to select elements, commands, and other items in
the software.

property
A unique characteristic of an element, object, symbol, or document. You can
display document properties in the Windows Explorer or by clicking Properties on
the File menu or Edit menu.

Properties for elements or objects have three different types, as defined on the
Properties dialog box:

• Style properties, as specified on the Format tab. Style properties affect the
format of the element.

• Size properties, as specified on the Info. Size properties affect characteristics of
the element, such as the length.

• User-defined properties, as created on the User tab. User-defined properties
are usually in the form of a text notation, such as cost, manufacturer, and so
forth You can change user-defined properties, but these changes have no affect
on the appearance of the element or object.

For example, a valve symbol’s style properties can include color, line style, and
width. Other user-defined properties stored with the symbol can include the
manufacturer, cost, or material. User-defined properties are displayed in the
Attribute Viewer when you select the valve symbol.
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relationship
A condition that exists for an individual element or between elements. You can
establish relationships as you place new elements or between elements already on
the drawing sheet. If Maintain Relationships is set, then the relationship controls
the modification behavior of the related elements. For example, if two lines have a
parallel relationship, they remain parallel when one of the lines is moved.

SmartSketch recognizes potential relationships as you draw. Relationship handles
are placed on related elements to represent maintained relationships.

relationship handle
A graphic used to represent a geometric relationship between elements, key points,
and dimensions, or between key points and elements. The relationship handle
shows that the designated relationship is being maintained.

Command Relationship Handle

Colinear

Connect

Concentric

Equal

Horizontal/Vertical

Tangent

Symmetric

Parallel

Perpendicular

Lock
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relationship indicator
A graphic that is displayed at the pointer when the software recognizes a
SmartSketch relationship.

Relationship Relationship Indicator

Endpoint

Midpoint

Intersection

Horizontal

Vertical

Point On Element

Perpendicular

Parallel

Tangent

Center

Select Tool
A tool that allows you to select elements before you run a command on them.

selection set
A single selected object or a group of selected objects.

shortcut menu
A menu that gives you quick access to commands that are related to the item you
are working with. The commands available on the shortcut menu depend upon the
selected element or active command. To activate the shortcut menu, click the right
mouse button.

Smart Label
A label that is associated to the attributes on an element or object. Smart Labels are
created with the tools on the Symbol Authoring Tools toolbar.

style
1. The appearance of geometry and annotations on the drawing sheet. For

example, an element’s color and line weight, the font used in a text box, and so
forth.
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2. A collection of formats or properties that you name and store as a group. When
you apply a style to a selected item, the software applies all the formats or
properties in the style to the element. The style types include: fill, dimension,
line, and text.

style resource document
Any .IGR or .RSC document that contains styles native to that document. A
template or document can reference several style resource documents. These styles
are copied into the current document when the styles are actually applied to
elements or annotations in the document.

style type
A type of style that is based on the type of element that the style affects.  The style
types include: fill, dimension, line, and text.

sweep angle
The angle that defines the length of an arc.

symbol
A document placed in a drawing. You can override and edit the properties and
style of the symbol. A document can be linked, or  embedded.

tangent relationship
A relationship between an arc or circle and another geometric element. The
elements share a common point that is not intersecting.

target point
The origin for coordinate measurements displayed by PinPoint. You can position
the target point anywhere on the drawing sheet.

template
A default set of properties that defines what a new document will look like. You
can use a template to set standards for a group of users or to define your own
preferences.

terminator
A graphic symbol, such as an arrow or dot, placed at the end of a leader.

text box
A rectangular element that contains text or symbols; you can place text boxes on
drawing sheets.
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toolbar
Toolbars are graphic menus with buttons that allow you to quickly access
commands. You can define custom toolbars or use the toolbars delivered with the
software.

user-defined property
A type of property created on the User tab of the Properties dialog box for the
element or object. User-defined properties are usually in the form of a text notation,
such as cost, manufacturer, and so forth You can change user-defined properties,
but these changes have no affect on the appearance of the element or object.

For example, user-defined properties stored with a valve symbol can include the
manufacturer, cost, or material. User-defined properties are displayed in the
Attribute Viewer when you select the valve symbol.

vertical relationship
A relationship that specifies that the end points of a line, or two key points, are
level with each other along the y axis.

window
An area defined by a standard border and buttons that is used to display
information in an application.
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A
ActiveCGM • 237
ActiveX

documents • 234
add-ins • 244

autosave • 256
software • 245

address • 16
angular dimensions • 186
annotations

adding to drawings • 201
formatting • 210, 212, 213

arcs
drawing • 95

areas
measuring • 189

arguments • 185, 192, 193,
195

assistance • 16, 234, 235
associative elements • 144,

146, 147, 152, 153, 154,
155, 156, 158

attributes
labels • 137, 205
using • 139

AutoCAD • 14, 17, 18
blocks • 285
documents • 278

axis
dimension • 183

B
background sheets

managing • 248
balloons

adding to drawings • 201
bearing • 191
blocks • 18

AutoCAD • 285

C
cells

MicroStation • 266
CGM • 237
chamfers

placing • 156
changing

associative elements • 144,
146, 147, 152, 153, 154,
155, 156, 158

display order • 171
drawings • 144, 146, 147, 148,

152, 153, 154, 155, 156,
158

circles
drawing • 95

closed boundaries
formatting • 217

connectors
elements • 93
symbols • 87

coordinate dimensions • 187
copying

documents • 222, 224
elements • 148
information • 226

creating
documents • 23
layer groups • 172, 173, 177,

266
crosshatching • 217
curves

drawing • 97
customizing

menus • 240
software • 240
toolbars • 240

cutting
documents • 222, 224
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elements • 146
information • 226

D
deleting

elements • 146
diameter dimensions • 186
dimensions • 182

angular • 186
axis • 183
changing existing elements •

162
coordinate • 187
diameter • 186
driving • 162
formatting • 210, 212, 213
groups • 187
linear • 186
not-to-scale • 182
placing • 18, 182
radial • 186

direct modification • 144, 146,
147, 148, 152, 153, 154,
155, 156, 158

display criteria
setting • 172, 173, 177, 266

display order
changing • 171

displaying
elements • 172, 173, 177, 266
layers • 172, 173, 177, 266
objects • 172, 173, 177, 266

distances
measuring • 189

documents
ActiveX • 234
copying • 222
creating • 23
cutting • 222, 226
embedding • 222, 224, 226
finding • 23
importing • 226
linking • 222, 224, 226
managing • 23
opening • 254
pasting • 222
printing • 252
properties • 23, 24
revising • 23
saving • 254
saving as templates • 25, 254
saving automatically • 256
saving to .CGM • 255
sending • 255

drag points • 121
drawing • 20

arcs • 95

circles • 95
curves • 97
elements • 90
ellipses • 95
freeform shapes • 97
lines • 92, 106, 112, 167
rectangles • 96
SmartSketch • 102
squares • 96
using intent zones • 105
with PinPoint • 18, 166, 167

drawing sheets
managing • 248
overview • 248
templates • 23

drawing tools • 102, 105
drawings

.CGM • 237
adding annotations to • 201
isometric • 99
modifying • 144, 146, 147,

148, 152, 153, 154, 155,
156, 158

symbols • 18
views • 17, 19, 175

driving dimensions • 162
drop points • 121

E
editing

drawings • 144, 146, 147, 148,
152, 153, 154, 155, 156,
158

elements
applying relationships to • 107,

158
changing shape of • 152
connectors • 93
copying • 148
cutting • 146
deleting • 146
displaying • 172, 173, 177, 266
drawing • 90
extending • 156
formatting • 210, 212, 213
grouping • 169
mirroring • 154
placing annotations on • 201
placing chamfers • 156
placing fillets • 156, 157
repeating • 91
rotating • 153
scaling • 155
selecting • 142, 144, 152, 169
trimming • 156
undoing • 91

ellipses
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drawing • 95
embedding • 222, 224

documents • 226
engineering fonts • 204
Excel • 15

working with • 226
expressions • 185, 192, 193,

195
extending

elements • 156
external reference files • 18

F
file properties • 23
files

importing • 222, 224
opening • 254
printing • 252
saving • 254

fillets
placing • 156, 157

filling • 217
fills

placing • 217
filters

selection • 142
setting • 172, 173, 177, 266

finding
documents • 23

fonts • 204
formatting

annotations • 210, 212, 213
closed boundaries • 217
dimensions • 210, 212, 213
elements • 210, 212, 213

freeform shapes
drawing • 97

functions • 185, 192, 193, 195

G
graphics

web • 237
grids • 85, 168
grouping

elements • 169
groups

dimension • 187

H
handles • 142

symbols • 121
hatching • 217
Help • 18, 20

hyperlinks • 236

I
images • 229

inserting into documents • 229
ImageScape • 229
importing

documents • 222, 224
installing

software • 19
Intellimouse

using • 178
intent zones • 105
Internet

accessing • 234
publishing • 234

Internet Explorer • 234
intranet

using • 234
isometric

drawings • 99

L
labels • 137, 205

reports • 85, 136
layer groups

creating • 172, 173, 177, 266
using • 172, 173, 177, 266

layers
displaying • 172, 173, 177, 266

leaders
adding to drawings • 201

learning
SmartSketch • 14

line types • 210
linear dimensions • 186
lines

drawing • 92, 106, 112, 167
lines,drawing • 112
linking • 222, 224

documents • 226
links • 236
locate zones • 102, 142
lock handles • 121

M
macros

creating • 240
mailing address • 16
maintaining

relationships • 108, 109, 158,
184

managing
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documents • 23
manipulating

elements • 171
measuring

areas • 189
distances • 189

menus
customizing • 240

Microsoft Office
working with • 226

MicroStation • 14, 19, 20
cells • 266
documents • 260

mirror handles • 121
mirroring

elements • 154
modifying

drawings • 144, 146, 147, 148,
152, 153, 154, 155, 156,
158

moving
elements • 171

N
not-to-scale

dimensions • 182

O
object handles • 142
objects

displaying • 172, 173, 177, 266
selecting • 142

Office applications
working with • 222, 224, 226

Office compatible • 226
OLE

linking and embedding • 222,
224

on-line Help • 14, 18, 20
opening

documents • 254
options

selecting • 142
order

of elements • 171
overview • 2

P
panning

Intellimouse • 178
paper and model units • 196
parametric handles • 121
pasting

documents • 222, 224, 226
patterns

creating • 148
phone number • 16
PickQuick • 142
PinPoint • 18, 166, 167

drawing with • 18, 167
placing

dimensions • 18, 182
fills • 217
symbols • 18

pointer
using feedback • 102

precision drawing • 18, 166,
167

printing
documents • 252

programming
macros • 240
SmartSketch • 15

properties
document • 23
documents • 24

R
radial dimensions • 186
raster images • 229
rectangles

drawing • 96
relationship handles • 102,

108
relationship indicators • 102
relationships • 144, 146, 147,

148, 152, 153, 154, 155,
156
applying to existing elements •

158
drawing with • 107
maintaining • 108, 109, 158,

184
reordering

elements • 171
repeating

elements • 91
reports • 85, 136
revising

documents • 23
rotate handles • 121
rotating

elements • 153

S
saving

documents • 254, 256
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scaling
drawing sheets • 248
elements • 155

Select Tool • 142, 144, 152,
169

selecting
elements • 142, 144, 152, 169
objects and elements • 142

selection
filters • 142
options • 142
sets • 142

sending
documents • 255

setting
display criteria • 172, 173, 177,

266
filters • 172, 173, 177, 266
units of measure • 24

sheets
managing • 248

sketching • 90, 95
Smart Labels • 137, 205
SmartSketch • 17, 18, 19, 20,

102
AutoCAD • 17
examples • 110, 112, 167
learning • 14
MicroStation • 19
overview • 2
programming • 15

programming • 240
squares

drawing • 96
styles • 213

elements • 210, 212
support • 234
symbol authoring

blank colors • 296
connectors • 300
display properties • 299
growing • 297
handles • 301
parametric symbols • 297
planning symbols • 294
programs • 298
scales • 302
Smart Text • 303
text • 303

Symbol Explorer
overview • 118, 119

symbols • 18
behavior • 121
connectors • 87
creating • 117
drag points • 121
drawings • 18

drop points • 121
editing • 124
handles • 121
labels • 121
manipulating • 130
mirroring • 127
placing • 18, 120
rotating • 128
scaling • 126
shortcut menu • 121
using • 18

system requirements • 4

T
tables

variables • 185, 192, 193, 195
technical support • 16, 234
templates • 23, 26

creating • 25, 254
text

adding to drawings • 201
toolbars

customizing • 240
tools

drawing • 105, 106
PinPoint • 18, 166, 167
select • 142, 144, 152, 169

ToolTips
symbols • 121

training • 14
trimming

elements • 156

U
undoing

elements • 91
units

model • 196
paper • 196

units of measure
setting • 24

V
Variable Table • 192, 193,

194, 195, 226
variables • 185, 192, 193, 195
viewing

grids • 168
Intellimouse • 178

views • 176
drawings • 17, 19, 175

Visual Basic • 240, 241
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W
web gallery • 235
web pages

linking • 236
windows • 176, 178
Word

working with • 226

World Wide Web
publishing • 234

Z
zones

intent • 105

zones
intent • 105


